Goldsmiths
Reading Lists

Guidelines for Bookmarking and List Creation
# Contents

**INTRODUCTION** .................................................................................................................. 3

**BOOKMARKING RESOURCES** ............................................................................................ 5

  How to Install the Bookmark Button .................................................................................. 5

  Bookmarking from the Library Catalogue ......................................................................... 7

  Combining a print and an e-book record ............................................................................. 10

  Bookmarking a Chapter of a Book ....................................................................................... 15

  Bookmarking a Journal Article ............................................................................................. 19

  Bookmarking from other library catalogues ...................................................................... 26

  Bookmarking from Book Vendors ......................................................................................... 29

  Bookmarking a Website ........................................................................................................ 31

  Bookmarking an Audio-Visual Clip (YouTube) ................................................................ 33

  Adding scanned readings to your lists ............................................................................... 35

**CREATING A LIST** .............................................................................................................. 38

  Naming a list ......................................................................................................................... 38

  Structuring a list .................................................................................................................. 40

  Populating a List with Bookmarked Resources .................................................................. 44

  Using Create and Add to List ............................................................................................. 45

  Setting Importance / Notes ................................................................................................. 48

  Saving your list .................................................................................................................... 50

  Editing a list ........................................................................................................................ 51

  Requesting a review ........................................................................................................... 52

  Publishing a list ................................................................................................................... 53

  Setting Privacy Controls ..................................................................................................... 55

  Inviting list publishers ........................................................................................................ 56

  Linking a list to a Module .................................................................................................... 57
INTRODUCTION

In order to access the Goldsmiths online reading lists management system, you need to accept an invitation sent to you by the system to become a member. Follow the link in your email, accept the invitation, and log on to the system with your Email ID (e.g. cuser001) when prompted. The web address for the system is: readinglists.gold.ac.uk. Please note: Firefox is recommended as the best browser for the system.

Creating an online reading list using this system is done in five easy steps:

1. **Bookmark all your resources using various sources of information**
   - Bookmarking requires installing the bookmarklet button onto your browser’s toolbar: this tool will enable you to harvest metadata for the resources you bookmark, in most cases, eliminating the need to enter bibliographic information manually for your titles.
   - You need to open your sources of information in additional tabs in your browser.
   - Primary sources for bookmarking are the Goldsmiths library catalogue, Goldsmiths online subscription databases (journals and articles databases, subject-specific databases), and Goldsmiths online repository, GRO.
   - Secondary sources are other library catalogues (e.g. UoL libraries); union catalogues (e.g. COPAC, WorldCat), book vendors (e.g. Amazon), the Internet, etc.

2. **Construct your list and populate it with your bookmarked resources**
   - Creating a list involves structuring and dividing it into sections, adding notes and pages.
   - Resources included in the list require tagging as to their importance.

3. **Request a review of your list from the library**
   - When you request a review, your list is sent to the library, and staff there will check that the items on your list are available in sufficient quantities, and will order items where necessary.
   - Your use of the Importance settings and setting your anticipated student numbers helps the library to decide what items to purchase and how many copies are needed.

4. **Publish your list**
   - Publishing a list takes it out from its draft status; your colleagues and the library can view it.
● It also allows you to invite list publishers, colleagues whom you would like to have contribute to your list

5. **Link your list to a module**

   ● Module titles are pre-downloaded from Student Services; just link your list to the right module

   ● The list is now available to your students

   ● However, as the list owner, you can edit and update it on a continuous basis

If you are new to the system and require training, please contact your relevant academic liaison librarian who will be more than happy to introduce you to the system.

*More information and guidelines, including video clips, is available through the Talis Aspire website at* [http://support.talisaspire.com/forums](http://support.talisaspire.com/forums)

*If you have any questions, please contact us at* [readinglists@gold.ac.uk](mailto:readinglists@gold.ac.uk)
Bookmarking Resources

How to Install the Bookmark Button

Log in to the system using your Email log-in (i.e. cuser001)

Click on the My Bookmarks link on the toolbar.

Click on the Install Bookmark Button.
Follow the instructions set out for Firefox: click and drag the Add to My Bookmarks button to your web browser’s bookmarks toolbar (if the toolbar is not there, enable it from the View menu).

The Add to My Bookmarks button will be there on your toolbar. Once it is there, you have the option of renaming from its properties by right-clicking on it.
Bookmarking from the Library Catalogue

Open another tab in your browser for the library homepage (http://www.gold.ac.uk/library/) and follow the link to the library catalogue.

Start searching for your title.
When you find the title you are looking for, click on the number beside it to open the full record.

Once you are on this screen click on your Add to My Bookmarks button to bookmark it.
In the window that appears, check the data on the left and click on **Create**.

Once the resource is bookmarked, go back to your original **reading lists tab**.
Click on My Bookmarks link; your first bookmarked resource will be there. All your bookmarked resources will be collected in here. Using the library catalogue, you can bookmark electronic books, journal titles, and DVDs in the same way.

<table>
<thead>
<tr>
<th>Type</th>
<th>Title</th>
<th>Author</th>
<th>Date Added</th>
<th>Notes</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Book</td>
<td>Promotional cultures: the rise and spread of advertising, public relations, marketing and branding</td>
<td>Davis, Aeron</td>
<td>6 minutes ago</td>
<td></td>
<td>Select action</td>
</tr>
<tr>
<td>Chapter</td>
<td>Reading for research in How to research</td>
<td>Blaxter, Lorraine, Bauld, Lorraine, Hughes, Christina, Tight, Malcolm</td>
<td>about 2 hours ago</td>
<td></td>
<td>Select action</td>
</tr>
</tbody>
</table>

### Combining a print and an e-book record

Note: If there is a print edition and an e-book version of a title in the library, we recommend that you create a record for the Print edition, and add a link to the e-book version using the Add field option. For example;

This item has both print and e-book editions in the library. Open the e-book by clicking on the links provided.
Follow the link to the e-book.

Click on the icon to agree to copyright restrictions.

Copy the link to the e-book from your browser.
Return to the library catalogue tab in your browser and click on the number beside the print edition to open the full record.

Click on Add to My Bookmarks.
In the **Add field** section, choose the **Web address** option from the drop-down menu, and then click **Add**.

In the field which now appears, **paste** the link to your e-book and tick **Online Resources box & Create**.
Go back to your reading list tab and click on your My Bookmarks link. Your newly bookmarked resource will be at the top of the list. Click on the new resource.

The bookmark for this resource now shows both the link to the e-book and the library availability for the print copy. The method for creating notes will be explained in detail later in the guidelines on List Creation.
Bookmarking a Chapter of a Book

It is possible to bookmark a specific chapter of a book to add to a reading list. We recommend that you only do this if you know the title of the chapter, the pages it covers, and the author, if it differs from the main author/editor of the text. If you are unsure of these details, you can add a study note to the item, referring your students to a particular chapter. This will be covered in detail later in the guidelines on List Creation.

Go to the library catalogue. Search the catalogue for the book which has the relevant chapter.

When you find the title you are looking for, click on the number beside it to open the full record.
Once you are on this screen click on your Add to My Bookmarks button to bookmark it.

In the Add field section, choose Has part (chapter, article, etc.) from the drop-down menu and click Add.
A new tab will appear where you can enter the details of your chapter. Select Chapter from the Resource Type drop-down menu.

Enter the Title of your chapter and then use the Add field section to enter any further details, such as Pages or Author. Note: You only need to enter the author if it differs from the overall author/editor of the book.
Once you have filled in all the details you require, click Create.

Click on the My Bookmarks link; your bookmarked chapter will be at the top of the list (you may need to refresh the page.)
Bookmarking a Journal Article

You can find journal articles to bookmark in two ways; through the Library Catalogue and through the Article Search + feature on the Library Website.

Bookmarking a Journal Article from the Library Catalogue

If you are bookmarking from the Library Catalogue, you need to already have the details of the Journal in which the article is published, as well as the volume, issue and year of publication.

Go to the Library Catalogue and click on the Journals tab.

Search for the Title of the Journal in which the Article is published.

Click on the FindIt@Gold icon, next to the Electronic Journal copy.
In the SFX box that appears, enter the Year, Volume, Issue and Page Number of the article and click Go.

Sometimes an article might open in a separate window instead of opening in an additional tab in your first window in which you have your bookmark button (Add To My Bookmarks) installed.
If this happens, even if the bookmarklet button (Add to My Bookmarks) is not visible on your browser’s toolbar, it will always be under the Bookmarks menu.

Your article is bookmarked in two parts: the first Article tab contains article information. Check the details to ensure that the Year, Volume and Issue information in present and correct. If this is an online resource, tick the Online Resource box to provide a link on the front page of the list.

Note: if proper bibliographic data fails to appear for a journal title/article at the point of bookmarking, you can use DOI Lookup if the web site offers a DOI (Digital Object Identifier) for that resource. Just copy and paste the DOI in the DOI Lookup field and click Lookup.
The second Is part of Journal tab contains journal title information. Click on Create to finish.

Go back to your original window and to the reading lists tab; refresh your screen and the journal article will be there at the top of your list.
Bookmarking a Journal Article from ArticleSearch+

Go to the Library Website (www.gold.ac.uk/library) and find the ArticleSearch+ box.

Search for an article in the search box, ensuring that you have ticked the Article search+ box. Search for your article and go in to the full text record following links; always prefer the HTML version over PDF if you have the option.
Sometimes an article might open in a separate window instead of opening in an additional tab in your first window in which you have your bookmark button installed.

When this happens, even if the bookmarklet button (Add to My Bookmarks) is not visible on your browser's toolbar, it will always be under the Bookmarks menu.
Your article is bookmarked in two parts: the first **Article** tab contains article information. Check the details to ensure that the **Year**, **Volume** and **Issue** information in present.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Media and Cultural Production</td>
</tr>
<tr>
<td>Author</td>
<td>Donald James</td>
</tr>
<tr>
<td>Year</td>
<td>2023</td>
</tr>
<tr>
<td>Volume</td>
<td>5</td>
</tr>
<tr>
<td>Issue</td>
<td>3</td>
</tr>
<tr>
<td>Pages</td>
<td>25-30</td>
</tr>
<tr>
<td>DOI</td>
<td>10.1016/S1874-0611(06)00102-4</td>
</tr>
</tbody>
</table>

**Note:** If proper bibliographic data fails to appear for a journal title/article at the point of bookmarking, you can use **DOI Lookup** if the web site offers a DOI (Digital Object Identifier) for that resource. Just copy and paste the DOI in the DOI Lookup field and click Lookup.

The second **Is part of Journal** tab contains journal title information. Click on **Create** to finish.

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title</td>
<td>Media, Culture &amp; Society</td>
</tr>
<tr>
<td>ISSN</td>
<td>0380.4417</td>
</tr>
</tbody>
</table>

Click here to open "Media, Culture and Cultural Production" in a new window.
Go back to your original window and to the reading lists tab; refresh your screen and the journal article is there at the top of your list.

Bookmarking from other library catalogues

Open the relevant library catalogue in another tab and search for your resource. We are using Senate House Library as an example.
Go into the record and click on **Add to My Bookmarks**.

Sometimes resources from other libraries are bookmarked as **Webpages** and proper data is not pulled in. When this happens, there is an additional small step you need to take to get the full bibliographic data.
Copy the **ISBN** of the title from the right into the **ISBN Lookup** field in the left. Then click on **Lookup**.

This action will pull in all available bibliographic data; you can now click on **Create**.
When you go back to your reading lists tab and refresh your screen, the latest addition will be at the top.

**Bookmarking from Book Vendors**

If you cannot find a resource in the library catalogue, you have the option of bookmarking it from a book vendor. Go to your vendor and find your resource. Click on your Add to My Bookmarks button.
Click on **Create**.

Go back to your **reading list tab** and click on your **My Bookmarks** link. Your newly bookmarked resource will be at the top of the list.
Note: if you bookmark a resource from a book vendor and the library already has a copy of it, when ISBN match up, the bibliographic data is going to come from the library catalogue and Library availability will be shown.

**Bookmarking a website**

Bookmarking resources from the Internet is quite straightforward. Using your bookmarklet tool you can bookmark any web page. Considerations would be how authoritative and permanent these web pages are. When bookmarking web pages, you should always choose ‘permalinks’ (permanent or persistent web links that are less likely to be broken) if they are provided by the web site.

Open a new tab, and type in the webpage you wish to bookmark. For this example we are using Cite Them Right Online (www.citethemrightonline.com).
Click on your Add to My Bookmarks button and check the information carried over. It will sometimes be necessary to amend the Website title details. Here for example, we can remove the “–Home” section from the Title. When you are happy with the details, click Create.

When you go back to your My Bookmarks list and refresh your screen, the latest addition will be at the top.
Bookmarking an Audio-Visual Clip (YouTube)

To bookmark a Youtube video, open a new tab and go to the Youtube website. Search for the video you wish to bookmark. Click Add to My Bookmarks.

Check that all the relevant information has been captured, and add anything additional if you wish using the Add field option. Click Create.
When you go back to your My Bookmarks list and refresh your screen, the bookmarked clip will be at the top.

If you click on the new bookmark, you will see that the Youtube clip is embedded into the reading list, allowing students to watch the material directly from the reading list.
Adding scanned readings to your lists

Open the edit screen of the list you wish to add scans to. Once you have accepted the Digitised Content permission, you will see the option to Request Digitisation on your edit screen.

In the record of the item you wish to scan, click on the Request Digitisation button and a pop-up box will appear. The reading list system will fill in most of the necessary information about title, author etc. but you will need to add the page numbers you wish to be scanned.
In the Course Details section you must add the Module Code, Module Title and Student numbers, and the term dates or the request cannot be processed. If you have added this information to the reading list already it will automatically be carried over.

The final step is simply to submit your request. The system automatically checks the Copyright for the scan and will give you an immediate response as to whether the scan is possible or not. If it is not possible you will be given a reason and also given the opportunity to submit the scan request anyway, so that the library scanning team can check if it will be possible, even if copyright approval cannot be given immediately.
Once the scan is approved you do not need to do anything further. Our scanning team will take over, make the scan and upload it, and it will automatically be added to your reading list as you can see in the example below.
Creating a List

Naming a list
In your reading lists system, go to My Lists and click on the Create a New List button.

In List Name, enter your module name and academic term (do not include module code to avoid repetition since the code will already be in the module name once your list is linked to its module). Under Description enter your name (name of the academic teaching or organising the module). Choose the correct Academic Year from the drop-down menu and enter your anticipated student numbers.
At this point the system will also give you the option to attach your list to the hierarchy, if possible. If you already know the module code and title of your module, then you can attach your draft list to the module code on the hierarchy. Simple click the Select Hierarchy button, type in the module name or module code, select the correct module and click Save. (If you prefer, you can attach your list to the hierarchy at a later stage, once the list is completed). Once this is done you can click Create list.
The system will then prompt you to choose a list owner. This is best assigned to the academic in charge of the course, this way a student can discover their reading list if they search using the name of an academic. This is optional, and can be decided at a later date.

**Structuring a list**

Structuring a list is just a matter of clicking and dragging the Icon front of New Section in to your list. You can also add New Note and New Page.
You will be asked to enter a Title each time you drag in a section. Study note is note to your students: it is optional and editable. Click Save.

You can create sub-sections within sections by clicking and dragging New Section to where you want it to be each time.
You have to enter a Title each time; Study note is optional. Click on Save.

Keep on repeating this until your sections are complete. You can have as many sections as you wish; you can have sub-sections within sections; you can start a new section and continue.

You can see in the Table of Contents at the top how your list is beginning to take shape. You can use the Table of Contents to move your sections around for re-structuring. All sections (names and notes) are editable and you can remove a section at any time.
You can also insert New Notes (which can be used for entering explanatory text and extensive notes, copied and pasted from Word documents, as well as for linking to VLE documents or to additional web pages) and New Pages (which can be used for inserting additional content, such as images) in your list structure.

You have the option of saving your draft and coming back to it later by using the Save Draft button at the top.

Note your Most Recent Bookmarks on the right. Resources you bookmarked last will always be at the top of the list. The list is searchable by title keyword, which is quite a useful feature if you have got hundreds of resources bookmarked.
Populating a List with Bookmarked Resources

Populating a list is again just a matter of clicking and dragging your bookmarks into your list.

In this way, you populate all of your sections. You can use a bookmark multiple times (for a textbook that is to be read every week, for example) and you can remove it any time.
Using Create and Add to List

If you wish, you can set up the structure of your list first, and then bookmark your resources and use the Create and Add to List function, which will automatically add your new bookmark to both your My Bookmarks list, but also to your new List.

Follow the guidelines above to Create a new list and structure your outline.

Go to the library catalogue and find your resource. Click Add to My Bookmarks.
Once you are satisfied with the information captured, click Create and Add to List.

In the box that appears you will be given the option to choose which list to add the item to from the Add to list drop-down menu, as well as which section of the list to place the item. You are also given the opportunity to add a Note for students, set the importance settings of the item, and also leave a Note for the library.
Once you are happy, click OK. Go back to your list and refresh the page. Your bookmarked item will be in the section you chose.
Setting Importance / Notes

It is important that students are given clear guidance as to the importance of a resource in a reading list. You do this by clicking on Set Importance for each resource when you are in the edit screen.

This will open a drop-down menu and you will be able to select from options.
You also have the option of inserting and editing notes, as well as editing importance if you want to change it, simply by clicking on **Edit notes and importance**.

In **Note for Student**, you can give specific instructions to students or put in any other comments about the resource. You can edit **Importance** of the resource. You can also put in a **Note for Library**.
Saving your List

Normally, your list is saved automatically whenever you make changes. However, to consolidate the saving process and to come out of the edit screen, simply click on Save Draft.

You will be taken to this screen and this is how the list is going to look to your students when you finally publish and attach it to a module. You can always go back to editing it from the Edit link. As you have yet to publish this list, you will note that it states that it is a draft list.
**Editing a List**

In **My Lists**, you will have all the lists that you created yourself. You can edit a reading list at any point: in its draft status, when it is published, and even after it is linked to a module and is available to your students. All you need to do is to open the **Select action** drop down menu next to the list you want to work on and select **Edit**. This will take you to the original edit screen where you can continue to work on your list.

You can see the other options in this drop-down menu, such as **View Draft** (to check student view), **Publish** (to take the list out from draft status and make it available to your colleagues and the library), and **Remove from View** (delete from the list).
Requesting Library Reviews

Once you complete your list, you can ask the library to review your list for acquisitions purposes. If you entered any notes for the library while populating your list with bookmarked resources, the library will be able to view them and respond to your requests. Go in to your list, click on the Review drop-down menu and click on Request review.

The dialog box that comes up will remind you to set importance for your resources, if you had not done so already, because purchase decisions made by the library will be based on this as well as other factors. Student number is another factor which affects decision-making. After you finish, click OK. You will receive an automated email when the library completes reviewing your list. This email will contain a link to your list with notes added by the library informing you about actions taken based on your notes to the library.
Publishing a List

After completing your list, you need to publish it. You can do this from several places: directly from My Lists as mentioned above without having to go in to the list first, from the View Draft screen below, or even in the Edit screen further below.
In whichever screen you are, the same dialog box will come up asking you to confirm your action. Once you *Publish* your list, it will be available to your colleagues for viewing. You can invite your colleagues to contribute to your lists. You can also ask the library to review your list for acquisitions purposes.

Note that it no longer states that this is a *draft list* once your list is published.
Setting Privacy Settings

Once your list has been published, you can choose to make the list accessible to all, or only to those who are logged in to the system. From the list view page, click on the Edit dropdown menu, and then click on Privacy Control.

In the box which appears, simply choose who you wish to be able to view the list, and click Save.
Inviting list publishers

When you are in the list, click on the Edit drop-down menu, and then click on Invite List Publishers (this means inviting other people to contribute to your lists, to become editors of your lists).

Enter the email address of the colleague you want to invite and click on send. The recipient will receive an invitation that he or she will need to accept before becoming a publisher (editor) for this list. You can invite multiple editors.

List publisher of the list "Study Skills" in Talis Aspire

Send invitation

Use the form below to enter one or more email addresses (separated by commas) of people you wish to invite to accept this role. They will receive a welcome email containing the message displayed below (which you can customise) and informing them of their new permissions.

- denotes mandatory field

Please ensure people are not using separating email addresses with commas, e.g. me@example.com, you@example.com

Message

"You have been invited to accept the role of List publisher in Talis Aspire for the list "Study Skills" (http://library.golds.ac.uk/uoh/169/36050250-4223-EPCC-C156-4231a3837f18). This will give you the following permissions:

- Can Assign License (Allows you to assign licenses to lists and pages, overriding defaults)
- Attach list to node (Allows you to add lists to any node in the hierarchy)
- Create lists (Allows you to create lists)
- Edit lists (Allows you to edit the specified list or lists)
- Publish lists (Allows you to publish lists, making them publicly accessible)
- Request review (Allows you to request list review)

This message will be emailed to the user, inviting them to accept the role."

Send invite
Linking a List to a Module

Go to the Home screen and then click on Browse hierarchy.

Find your School and click on it.
Find your **Module** and click on it.

Under **Lists linked to this module**, open the drop-down list that contains all reading lists created by you. Select the reading list you want to attach to the module and click on **Add**.
Your list will appear under Lists linked to this Module and it will now be available to your students. Note Actions available to you under the Select action drop-down menu, such as Edit, Copy, Remove, and Export.